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Congratulations and thank you for buying the SBIG ST-5C Advanced CCD Camera.  This
camera offers incredible performance in a small package for a moderate cost.  Using the camera
will expand your astronomical experience by allowing you to easily take images like the ones
you've seen in books and magazines, but never seen when peeking through the eyepiece.  CCD
cameras offer convenience, high sensitivity (a typical deep-sky image is several minutes), and
advanced image processing techniques that film just can't match.  While CCDs will probably
never replace film in its large format, CCDs offer ease of use and allow a wide range of scientific
measurements.  Their use has established a whole new field of Astronomy.  Some of the
features you'll discover about your camera include:

• Based on the Texas Instrument TC255 CCD with 320 x 240 pixels that are 10
microns square.

• Double Correlated Sampling readout with 16 Bit A/D for the lowest possible
noise.

• Convenient and fast parallel interface offers full frame download times under 4
seconds.

• Thermoelectric cooling gives sky background limited performance.

• Integral Shutter Wheel that can be replaced with a Color Filter Wheel for Tricolor
imaging.

• Telescope port for use as an Autoguider.

• Advanced CCDOPS software for data acquisition, display and processing.

• Track and Accumulate1for hassle-free long duration exposures.

• 12 VDC operation allows use in field with a car battery.

• Standard T-Thread allows use with a variety of telescope adapters including the
standard 1.25 inch nosepiece and eyepiece projection units.

This manual  is organized for two types of use.  Some sections have been designed to be read
through from the start while you're learning about the camera and the software whereas other
sections are to be used for reference.  Briefly the manual consists of the following sections:

• Section 1 describes CCD cameras and how they work.  While it is the first section
of the manual, it is a bit technical, and some users may wish to skip ahead to the
second section then come back to this section once they have had a little hand's
on experience.

• Section 2 tells you how to install the camera and CCDOPS camera software and
takes you step by step through the process of taking your first images.  Even if
you have experience with other cameras you should browse through this section
and read any sections that are new to you.  Also for further training and detailed
technical information regarding the CCDOPS software for the ST-5C please refer
to the separate CCDOPS manual.

• Section 3 presents some more detailed information about how you use the
camera for some slightly more advanced tasks.  The discussion of even more
advanced topics is continued in Appendix D.  Once you have become familiar
with the basic operations of the camera you will want to read these sections.

• Sections 4 and 5 provide a Glossary of common CCD imaging terms, a Question
and Answer section on the most common questions you'll have and a section of

                                                                        
1 Track and Accumulate covered by SBIG US Patent 5,365,269.
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useful hints and tips for using the camera.  Again, this is a good section to read
once you have had a little time with the camera.

• Finally, the Appendices provide a wealth of technical information about the
camera.
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1. Introduction to CCD Cameras

The CCD (charge coupled device) is very good at the most difficult astronomical imaging
problem: imaging small, faint objects.  For such scenes, long film exposures are typically
required.  The CCD based system has several advantages over film: greater speed, quantitative
accuracy, ability to increase contrast and subtract sky background with a few keystrokes, the
ability to co-add multiple images without tedious dark room operations, wider spectral range,
and instant examination of the images at the telescope for quality.  Film has the advantages of a
much larger format,  one-step color, and independence of the wall plug (the ST-5C camera can
be battery operated in conjunction with a laptop computer, though).  After some use, you will
find that film is best for producing sensational large area color pictures, and the CCD is best for
planets, small faint objects, and general scientific work such as variable star monitoring and
position determination.  It is for this reason that we designed the camera to support both efforts,
as an imaging camera and as an auto-guider to aid astrophotography.

1.1. How CCDs Work

The CCD is a solid-state imaging detector that is quite commonly used in video tape cameras
and is starting to find acceptance in still frame cameras.  It has been used for Astronomical
Imaging for over twenty years.  The CCD is arranged as a rectangular array of imaging
elements called pixels.  An image is formed by reading the intensity of these pixels.

The basic function of the CCD detector is to convert an incoming photon of light to an
electron which is stored in the detector array until it is read out, thus producing data which
your computer can display as an image.  How this is accomplished is eloquently described in a
paper by James Janesick and Tom Elliott of the Jet Propulsion Laboratory:

"Imagine an array of buckets covering a field.  After a rainstorm, the buckets are
sent by conveyor belts to a metering station where the amount of water in each
bucket is measured.  Then a computer would take these data and display a
picture of how much rain fell on each part of the field.   In a CCD the "raindrops"
are photons, the "buckets" the pixels, the "conveyor belts" the CCD shift registers
and the "metering system" an on-chip amplifier.

Technically speaking the CCD must perform four tasks in generating an image.
These functions are:

1) charge generation
2) charge collection
3) charge transfer
4) charge detection

The first operation relies on a physical process known as the photoelectric effect -
when photons or particles strike certain materials free electrons are liberated.  In
the second step the photoelectrons are collected in the nearest discrete collecting
sites or pixels.  The collection sites are defined by an array of electrodes, called
gates, formed on the CCD.  The third operation, charge transfer, is accomplished
by manipulating the voltage on the gates in a systematic way so the signal
electrons move down the vertical registers from one pixel to the next in a
conveyor-belt like fashion.  At the end of each column is a horizontal register of
pixels.  This register collects a line at a time and then transports the charge
packets in a serial manner to an on-chip amplifier.  The final operating step,
charge detection, is when individual charge packets are converted to an output
voltage.  The voltage for each pixel can be amplified off-chip and digitally
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encoded and stored in a computer to be reconstructed and displayed on a
television monitor."2

X=1 X=M

Y=1

Y=N

Output
Readout Register

Amplifier

Figure 1.1 - CCD Structure

1.2. CCDs Applied to Astronomical Imaging

When CCDs are applied to astronomy, with the relatively long exposure times (compared to the
30 frames per second used in video camera), special considerations need to be applied to the
system design to achieve the best performance.  This section discusses the cooling and dark
frame requirements of astronomical imaging.

1.2.1. Cooling

Random noise and dark current combine to place a lower limit on the ability of the CCD to
detect faint light sources.  If the CCD is producing more electrons from its own internal
processes than is produced by photons from a distant object, the signal from the object is said to
be "lost in the noise", and will be impossible to display without sophisticated image processing
software.  Noise here refers to the "gritty" look of short exposure images.

Internally, the CCD generates thermal noise and readout noise caused by the operation
of the electronics on the chip.  The goal is to eliminate unwanted sources of electron production
in the chip and thus make the detector more sensitive to the remaining source of electron
production by incoming photons.  As you can imagine, the reduction of unwanted noise is
important for the best performance of the CCD.

Dark current is thermally generated electrons in the device itself.  All CCDs have dark
current which can cause each pixel to fill with electrons in only a few seconds at room
temperature even in the absence of light.  By cooling the CCD, this source of noise is reduced,
the sensitivity increased, and longer exposures are possible.  In fact, for every 8°C of additional
cooling, the dark current in the CCD is reduced to half.  In your camera for example, cooling the
CCD from room temperature (25°C) down to 0°C results in an eight-fold reduction in dark
current.

The ST-5C uses a thermoelectric (TE) cooler to cool the CCD.  The TE cooler is a solid-
state device that acts like a heat pump.  By running electrical current through the TE cooler, heat
is pumped out of the CCD through the TE cooler.  The camera also has a temperature sensing
thermistor attached to the CCD  to monitor the temperature, and the camera electronics control

                                                                        
2 "History and Advancements of Large Area Array Scientific CCD Imagers", James Janesick, Tom

Elliott.  Jet Propulsion Laboratory, California Institute of Technology, CCD Advanced Development
Group.



Section 1 - Introduction to CCD Cameras

Page 5

the temperature at a user determined value for long periods.   As a result, exposures up to an
hour long are possible, and saturation of the CCD by the sky background typically limits the
exposure time.

The sky background conditions also increase the noise in images, and in fact, as far as
the CCD is concerned, there is no difference between the noise caused by dark current and that
from sky background.  If your sky conditions are causing photoelectrons to be generated at the
rate of 100 e-/pixel/sec for example, increasing the cooling beyond the point where the dark
current is roughly half that amount will not improve the quality of the image.  This very reason
is why deep sky filters are so popular with astrophotography.  They reduce the sky background
level, increasing the contrast of dim objects, and can be used to advantage with the CCD
camera.

1.2.2. Dark Frames

No matter how much care is taken to reduce all sources of unwanted noise, some will remain.
Fortunately, however, due to the nature of electronic imaging and the use of computers for
storing and manipulating data, this remaining noise can be drastically reduced by the
subtraction of a dark frame from the raw light image.  A dark frame is simply an image taken at
the same temperature and for the same duration as the light frame with the source of light to
the CCD blocked so that you get an "image" of the dark.  This dark frame will contain an image
of the noise caused by dark current (thermal noise) and other fixed pattern noise  When the
dark frame is subtracted from the light frame, this pattern noise is removed from the resulting
image.  The CCDOPS software can automatically perform this.

1.3. The Various CCD Parameters and How they Affect Imaging

If you scan the CCD related literature you will see a slew of new terms describing CCDs and
their performance.  In this section we will discuss the more common CCD parameters and their
effects in an imaging application.

1.3.1. Pixel Size

Every CCD, independent of the manufacturer, is divided into a relatively large number of small
pixels.  In your CCD camera the imaging area of the CCD is 3.2 mm x 2.4 mm and the pixels are
10 microns square (1 micron is one thousandth of a millimeter or roughly 0.00004").  If you
looked at the CCDs available from the various manufacturers you would see that their pixels
typically vary from 7 microns on the small end to 25 microns on the large end. There are
advantages and disadvantages associated with the size of pixels in a CCD.

While having small pixels may seem advantageous in terms of offering "higher
resolution", large pixels gather more light and are thus "more sensitive".  You can also adjust
your telescope configuration to accommodate various size pixels, using faster telescopes to
increase the speed of small pixel CCDs or longer focal lengths to increase the resolution of
larger pixel CCDs.

Often times the basic goal is to match the CCD resolution to the telescope resolution and
to the overall seeing.  It would be a waste to use a pixel size of 7 microns on a telescope with a
spot size of 25 microns or to configure the CCD/telescope to produce an image scale of 10 arc-
seconds per pixel when you're looking for fine planetary detail.

1.3.2. Full Well Capacity

The full well capacity of a CCD is the number of electrons each pixel can hold before the pixels
are full.  While this may seem like an important consideration in choosing a camera, you need
to think about how the camera is used.
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The typical CCD astronomer is taking images of faint galaxies and nebulae.  While
exposures are long, you very rarely will expose the CCD to more than a small fraction of its full
well capacity on these dim objects.  Some stars in the image will expose to the full well capacity,
but not much of the nebulosity.  So even though small pixel size CCDs have lower full well
capacities than large pixel CCDs, most applications do not stress this CCD parameter.

1.3.3. Dark Current

Every CCD, independent of manufacturer, will suffer from dark current.  One manufacturer's
CCD may have lower dark current than another manufacturer's, but they all have dark current.
The only way to reduce dark current in a CCD is by cooling it, and in general the more cooling,
the better.  But there is a limit.

In astronomical imaging, you're looking at objects against the sky background, and that
sky background isn't perfectly dark.  City light and sky glow itself cause the sky to actually
have some brightness.  As far as the CCD is concerned from a noise standpoint, it can't tell the
difference between electrons generated by dark current and those generated by sky
background.  Because of this, cooling the CCD beyond the point where the dark current is less
than the sky background will not result in any further improvement in image quality.

As a matter of interest, your CCD camera produces roughly 1 e-/p/s
(electron/pixel/second) of dark current when cooled to -5°C and a typical dark sky through an
F/10 telescope produces 3 e-/p/s.  Sky background scales inversely with the square of the
telescope's F-Ratio and for example is 25 times higher at F/2 than it is at F/10.

1.3.4. Read Noise

The read noise of a CCD is the noise inherent in the CCD's amplifier and charge detection
circuitry.  This read noise forms a noise floor below which the CCD will not detect weak signals.
Something you're imaging must rise above the read noise level before you'll be able to see it.

Since the read noise is the noise floor, it is really only important for very short exposures
of dim objects.  As the signal from your target or the signal from the sky background builds up,
it will cross the noise floor and the noise in the image will be determined only by the brightness
of the target and the exposure time, not the CCD's read noise.  For example, the read noise in
your CCD camera is 30 electrons RMS, and when your signal has built up to 900 electrons (30
electrons RMS squared) the read noise is no longer the dominant noise in the final image.  At
F/10 the sky background alone achieves this level in 6 minutes and at F/2 it occurs in 12
seconds!

There are techniques CCD manufacturers can use to reduce the read noise.  One of the
techniques is Double Correlated Sampling where some of the noise in the amplifier is
subtracted out by making two measurements per pixel rather than one.  Your Advanced CCD
camera uses such a technique.

1.3.5. Frame Transfer

There are two basic types of CCDs available: Frame Transfer CCDs like the one used in your
camera and Full Frame CCDs.  A Frame Transfer CCD is divided into 2 separate areas on the
CCD.  One area, called the image area, is sensitive to light and that is where the image builds up
when exposed to light.  But CCDs can't be "turned off" and they continue to build up signal,
even throughout the readout phase.  Remember that during readout, the rows of charge are
shifted up to the readout register.  It's sort of like advancing the film in a camera with the
shutter open.  Unless the CCD is covered with a shutter during the readout, the continued
buildup of signal throughout the readout phase will cause streaking.

The second area in the Frame Transfer CCD, called the storage area, is shielded from
light by an aluminum layer on the CCD.  This storage area is used as an "electronic shutter"
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whereby data from the image area, after completing the exposure, is rapidly shifted into the
storage area where it is then digitized.  A fast shift from the imaging area to the storage area
insures minimal streaking.  Once the image is in the storage area, it can read out by the camera
electronics without causing streaking.

The simple answer to streaking you might say is to use a mechanical shutter, and in fact
your camera does have a shutter but the accurate timing of  exposures is not limited by the
speed of that shutter but by how rapidly the imaging area can be moved into the storage area.
In this way the mechanical shutter is used to cover the CCD chip for taking dark frames while
short exposure images can be achieved electronically, without the limitations of mechanical
shutters.

1.3.6. Antiblooming Protection

As described above, the individual pixels in the CCD have a limited full well capacity.  When a
pixel fills up with charge, the excess charge generated has to go somewhere.  Again, there are
two basic types of CCDs available.

Standard CCDs, when reaching the saturation point, will spill the charge into
neighboring pixels, typically up and down the column in a line that is called blooming.  If, for
example, you had a pixel that was exposed to 10 times its full well capacity, it would bloom
until a column of ten pixels was saturated, causing streaks in the image.  The second type of
CCD offers Antiblooming protection.

In an Antiblooming protected CCD, when the charge in the pixel gets above some
threshold, typically one-half the full well capacity, the majority of the excess charge gets bled off
into a drain on the CCD.  For example, a CCD with a 100X Antiblooming protection will drain
off 99% of the excess charge, allowing a pixel to overexpose to 100-fold before blooming occurs.

There is a price to pay, however, with Antiblooming protection and that's why
manufacturers produce both protected and unprotected CCDs.  First off, the process of
Antiblooming protection causes a nonlinearity in the response of a CCD.  If you were trying to
make accurate Photometric measurements, you would want the integrated star brightness kept
below the knee where the Antiblooming kicks in.  The second detriment to some Antiblooming
protected CCDs is that at the integrated circuit level, the Antiblooming structures can reduce
the sensitive area of the individual pixels, causing a slight reduction in overall sensitivity.

The Texas Instruments (TI) TC255 CCD used in your camera offers variable
Antiblooming protection and, according to TI, the structures required to implement the
Antiblooming protection do not cause any reduction in sensitivity.  The benefit of the variable
Antiblooming protection in the TC255 is that you can select the amount of Antiblooming you
want, using just a small amount for fields where no bright stars would cause blooming and a
large amount for  objects like the Orion Nebula where a bright star in the field of view would
otherwise bloom.  With the TC255, using the minimum amount of Antiblooming protection also
has a beneficial effect in that it reduces the dark current in the CCD.

1.3.7. A/D Bits and Digitization Rate

If you browse through the literature on specifications of the various CCD cameras, you see
some of them are 8 bits, some are 12 bits and some are 16 bits.  While in general an A/D
(Analog to Digital) converter with greater precision is desired, there is a point where the extra
precision doesn't get you any increased performance.  In most CCD cameras it's actually the
CCD that limits the performance, not the A/D converter.

As a starting point, you can take the CCD's full well capacity and divide by the CCD's
read noise to come up with a figure for the CCD's dynamic range.  In this way the dynamic
range is the ratio of the brightest object you could image without saturating to the dimmest
object you could detect.  You could see that a 16 bit A/D with a dynamic range of 65,000 is
overkill for a CCD with a dynamic range of 4000, for example.  Let's look at your camera.  The
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CCD has a full well capacity of 50,000 electrons and a read noise of 30 electrons RMS giving a
dynamic range of roughly 1700. A 12 bit A/D offers a dynamic range of 4096 and would cover
that CCD fairly well.

One thing you do want to do with the A/D is make sure that the A/D's noise (typically
1 count) is lower than the CCD's noise so that you are truly CCD limited.  Setting the A/D to
have one-eighth the noise of the CCD allows averaging several images to improve noise.
Applying this criteria to the TC255, you would want an A/D with a dynamic range of 10,000 or
so (a 14 bit A/D has 16,000 dynamic range).

Finally, the CCDs can be used in a mode where the pixels are combined in a process
called binning which is described in detail below.  Binning reduces the CCD's spatial resolution
like increasing grain size in film, but increases the CCD's dynamic range.  With your camera
you can bin the CCD 2 by 2 resulting in another factor of 4 in dynamic range which gets us up
to 40,000 or so, hence the need for a 16 bit A/D.  While the camera only achieves 16,000 counts
unbinned, allowing it to achieve 65,000 counts binned allows taking advantage of the extra
dynamic range inherent in binning.

The final consideration regarding the A/D is how fast the data is digitized and
downloaded from the CCD to the computer.   The A/D is not the only contributor to that time.
The actual transmission of the data to the computer is a significant portion of it.  In your camera
an entire image can be digitized by the A/D converter and sent to the PC in 3.5 seconds.  This is
done using the PC's standard Parallel port without requiring the addition of expensive (and
difficult to configure) SCSI adapter cards.

1.3.8. Binning

Binning is a process where multiple pixels in the CCD are combined to form a single larger
pixel.  This reduces the CCD's resolution but increases the sensitivity.  Different CCDs from
various manufacturers support different types of binning.

Some CCDs support on-chip binning, where all the pixels in the group are combined in
the CCD itself.  This has the advantages of lower noise (a single read noise is generated for the
group of pixels) and higher speed digitization since fewer pixels are involved. In imaging
applications you tend to bin the images in both directions to preserve a "square" aspect ratio.
The one final advantage of binning is that it increases the overall image throughput, reducing
the digitize and download times due to the reduced number of pixels involved.

The camera software allows you to select a High resolution 10 micron square mode
where the pixels are unbinned and a Low resolution mode resulting in 20 micron square pixels.
The latter is useful for fast acquisition of faint objects.

1.3.9. Spectral Response

Like film, CCDs have a varying response to differing wavelengths.  The basic fabrication
techniques used in manufacturing the CCDs greatly affect their spectral response.  At the
extreme Red end of the spectrum, the CCDs loose their sensitivity because the photons simply
do not have enough energy to generate electrons in the CCD wells.  At the Blue end of the
spectrum, the photons do not penetrate deep enough into the CCDs to get into the wells and are
stopped by the top layers of the CCD.  Between the Red and the Blue, interference effects in the
top layers of the CCD can also cause peaks and valleys in the response.

This affects you in several ways.  The most obvious is the overall effect that causes you
to take longer exposures with CCDs for various colors.  For example, when taking color images,
your Blue exposure is typically several times longer than the Red exposure to give an image
with similar quality or Signal/Noise.   One last interesting note about CCD's spectral response
is that they have much more response in the near infrared than film.
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The TC255 CCD used in your camera is made using Texas Instrument's Virtual Phase
technology that gives excellent Blue response compared to other CCDs.  This is achieved by
reducing the number of photon-absorbing clocking gates in the CCD.

Figure 1.2 - CCD Quantum Efficiency

1.4. Camera Hardware Architecture

This section describes the ST-5C Advanced CCD Camera from a systems standpoint.  It
describes the elements that comprise a CCD camera and the functions they provide.  Please
refer to the figure below as you read through this section.
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Figure 1.3 - CCD System Block Diagram
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The ST-5C camera is a two piece system consisting of an Optical Head and a CPU.  The Optical
Head houses the CCD and Preamplifier and the CPU contains the Readout and Control
Electronics. The CPU is powered by an external 12 VDC  source.  For users in the US and in
Japan, wall tranformers rated at 12 VDC / 2 Amps are supplied, for users outside these areas a
Cigarette Lighter Adapter is provided.  Finally, the CPU interfaces to the PC through the
Parallel Port and is controlled by the software.

Examining the Optical Head in more detail shows the "front end" of any CCD camera
which is the CCD sensor itself.  In this case the CCD is the Texas Instruments TC255.  The CCD
is cooled by mounting it on a thermoelectric (TE) cooler.  The TE cooler pumps heat out of the
CCD and dissipates it into the camera body where it is removed by convection and conduction
to the atmosphere.

Since the CCD is cooled below 0°C (32 °F), some provision must be made to prevent
frost from forming on the CCD.  The camera has the CCD/TE Cooler mounted in a windowed
hermetic chamber sealed with an O-Ring.  The hermetic chamber does not need to be a vacuum,
and contains a desiccant packet to absorb the small amount of moisture that might condense.

Other elements contained in the optical head include the preamplifier and a rotating
shutter wheel.  The shutter wheel makes taking dark frames a simple matter of pushing a
button on the computer.  Remember that the shutter wheel does not perform the task of timing
the exposure, it merely blocks the light from the CCD to facilitate taking dark images.  Timing
of exposures is based upon the electronic clocking scheme applied to the CCD.  Also, the shutter
wheel can be replaced by a Color Filter Wheel which allows taking Tricolor images and dark
shuttering.

The Microcontroller acts as the "brains" of the camera electronics.  It is responsible for
starting and stopping exposures in the CCD, clearing the CCD at the start of the exposure and
transferring the image into the CCD's storage area at the end of the exposure.  The
microcontroller also regulates the CCD's temperature by monitoring the temperature sensor
and adjusting the power to the TE cooler.  Finally, the microcontroller provides control of the
Shutter/Filter Wheel and the Telescope Port that is used when Autoguiding.

The final element of the camera system is the host computer and operating software.
The CCDOPS software runs under Windows 95, Macintosh OS and MS-DOS and is used to
acquire, display and process images from the camera.  As you will learn, CCDOPS is a powerful
package with a user-friendly interface.  It is unequaled in the industry.  Also, third party
software packages such as Software Bisque's SkyPro for Windows will support the ST-5C
Advanced CCD Camera and open up a whole realm of capabilities including integrated
Telescope and Camera control.
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2. The First Day with the Camera

This section takes you step-by-step through your first use of the software and camera.

2.1. Setting up the System

This section tells you how to install the CCDOPS software and establish a communications link
with the camera.

2.1.1 Installing the CCDOPS Software

The CCDOPS software is provided on floppy diskette, and should be copied to your system's
hard disk prior to use.  Install the software into a directory or folder on your hard disk by
following the instructions below:

Windows 95 Users
1. Insert diskette number 1 into the floppy disk drive.
2. From the Start menu use the Run command to run A:SETUP.EXE.
3. Follow the directions for the included installer.

Note: Should you ever want to uninstall the CCDOPS for Windows 95 software run the
Add/Remove Programs utility in the Settings->Control Panel item in the Start menu.
This way any DLLs that get installed in the Windows directory are handled correctly.

MS-DOS Users
1. Insert the diskette into the floppy disk drive.
2. At the MS-DOS prompt type "CD \" then hit the Enter key to log into the root

directory of your hard disk.
3. Type "MKDIR CCDOPS" then hit the Enter key to create a directory for the software.
4. Type "CD CCDOPS" then hit the Enter key to make that directory active.
5. Type "COPY A:*.*" or "COPY B:*.*" depending on which floppy drive you are using

then hit Enter to copy all the software to the CCDOPS directory on your hard disk.

When you want to run the software, turn on your computer and type in the following
sequence of commands at the MS-DOS prompt:

CD \CCDOPS <hit Return>
CCDOPS <hit Return>

Note: CCDOPS for DOS was not designed to run under Microsoft Windows.  If you use it
under Windows be advised that you may encounter difficulties and/or your ability to
communicate with the camera at high speeds may be limited.

Macintosh OS Users
1. Insert the diskette into the floppy disk drive.
2. Create a new folder on your hard disk named CCDOPS.
3. Click and drag all the files on the CCDOPS diskette into the folder you've just created.

After you have finished installing the software place the floppy disk in a safe place in case you
need to reinstall it later.

Internet Users Note that you can always download the latest version of the CCDOPS
software from SBIG's homepage <www.sbig.com>.
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2.1.2. Getting Acquainted with CCDOPS Software

Upon entering CCDOPS a warning (referred to as an Alert) states no camera is hooked up yet.
To proceed, hit any key and you are presented with our user friendly menu based interface
shown in the figure below:

*  File  Camera  Display  Utility  Misc  Track  Filter

 Status 

 Data Buffer 
Name:M27.STC
 Camera 
Link:
 Res:

Welcome to the CCDOPS Software

Open   Alt-O
Save   Alt-s

 Display mode: Analysis  Photo
Auto contrast: Yes  No
   Background: 100

[ Enter ] [  Esc  ]

 Display 

Menu Bar

Dialog

Menu

Status Box

Camera Status

Figure 2.1 - The CCDOPS User Interface

The menu bar starts at the top left and extends horizontally to the AO menu item on the right.
Navigating between these menus can be accomplished with a mouse or left/right cursor arrows
on your keyboard.  Go ahead now and move between these items.

The File menu is the most frequently used since it navigates you toward image retrieval
(Open command) and the image Save command.  It also is the way to the off switch, via the
Exit/Quit command.  To pull down the File menu, highlight it and simply hit Enter or click on
it when highlighted.  To leave it, hit Esc key or click on another menu.

Camera Menu

Move to the right and Camera menu is highlighted.  Pull it down to see the available
commands.  None of these function yet since a camera is not hooked up or powered.  Notice
that you are alerted to this fact by the software when you hit Enter on a highlighted command.

Display Menu

Moving right again to the Display menu, you see the available commands. You can use the
mouse or your up/down cursors or mouse to navigate between these. Similarly, when selected,
error messages come up in all but the Slide Show command. Select it.  Now you are prompted
by a new window (referred to as a Dialog) to select a slide show script.  Move the highlighted
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box to the DEMO.SLD script which we created for you and hit Enter.  Now you are presented
with more choices.  Temporarily ignore these and hit Enter again.  When in doubt, just hit Enter
to use the standard defaults.  You are now viewing a library of images created with the TC-255
chip in your camera.  These will run until you hit Esc.

You can adjust your monitor's brightness or contrast for best view.  If you find an image
you wish to freeze, hit the Space bar.  Hit the R key to resume slide show or hit any other key to
fast forward through the images.

File Menu

To call up specific images stored in image files, Esc  the Slide Show command.  In order to
display an image, it is necessary to first select its image file.  Move the cursor to the File menu,
hit Enter, select  the Open command and again hit Enter.  Now you see the File Open dialog
presenting you with many choices.  There are files and file directories  Directories are created by
the software and later by you to organize and store images. The current directory you are in is
noted at the top.  Move the highlighted cursor to the MOON.255 file and click on it twice in
short succession (double-click) or hit Enter.

You are first shown with the image header data pertaining to that image. After viewing
the data, hit Enter. What happens next depends on the OS you are running under:

Windows 95/Macintosh OS
The image is displayed in a window.  Like all windows under these Operating Systems
they can be moved around and resized.  CCDOPS allows you have one image open at a
time.

When you have an image open another window appears on the desktop named
the Contrast Window.  Settings in the Contrast Window control how the image is
displayed.  Adjusting the Background setting and hitting the Do It/Apply button
changes the brightness of the image. The Range setting controls the contrast.  You can
enlarge or reduce the image with the Mag pop-up and apply a light Smoothing or Invert
the image.  Finally the Auto checkbox lets CCDOPS set the Background and Range items
automatically based upon the image data and is always a good first step.

DOS
Highlight the Display menu with a mouse click or the cursor keys.  Execute the Image
command and the software brings up the Display Settings dialog.  Use the mouse or the
cursor keys to select the Photo display mode and then hit Enter one last time and your
selected image is now displayed.

If you have a VESA based SVGA  display adapter, depress the up/down arrows
to adjust  the image brightness and right/left arrows to adjust its contrast. This feature
allows real time display optimizing.  If you are not getting a satisfactory image display,
refer to the Graphics Setup command in the CCDOPS Software Manual for help. Note
that images will almost always look better on a video monitor than from a laptop LCD.
If you wish to increase image size, again refer to Graphics Setup command in the
CCDOPS Software Manual  and change the graphics card to VGA or MCGA.  Your
selected image will still be held in the image buffer, ready for redisplay when selected.
When you're done with looking at the image hit Esc to return to main menu.

Utility Menu

The next menu to the right, Utility, allows you to modify an image. Pull down the Utility menu.
These commands can be used without permanently modifying the selected image until you
save it.  Move back to File menu.

Open and display the Jupiter image and study the image briefly.  Esc back to the main
menu.  Move to Utility menu and execute the Sharpen command.   In the Sharpen dialog select
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Lunar/Planetary and Medium settings.  Hit Enter.  A sharpened image of Jupiter comes up and
notice how the red spot (light oval) now shows on Jupiter's right side by one of its moons.  Also,
cloud band detail has been enhanced.  At this point, you could save this image, but be cautious
and make sure you have read the manual and understand what the save function can do to the
original unsharpened Jupiter image.  You are only a few keystrokes away from modifying your
original data permanently unless you heed the warning box displayed while executing the Save
command.  No problem, just hit Esc or be sure to rename the modified Jupiter file before saving
it so as not to modify the original file.

Display the sharpened Jupiter image.  We will go to the Utility menu and do something
else to this image. Select the Enlarge Image command and hit Enter.  You have magnified the
number of pixels in this image four-fold.  Be aware that this would increase the size of the
image on disk four-fold as well if you saved it.  Notice that even more detail becomes visible.
Vary the contrast and brightness for the best view.

You have just successfully retrieved an image and optimized it for viewing.  Since this is
any easily repeated example, let's get rid of the modified image by hitting Esc and moving to
Misc menu on the main menu bar.

Misc Menu

The Misc menu contains several commands that are used to configure CCDOPS to you
particular computer and graphics hardware.  For now let's move right over to the Track Menu.

Track Menu

In the Track menu you see several commands.  Except for the Track and Accumulate command,
these all pertain to using your CCD camera as a separate auto guider for astrophotography with
accessories such as a Radial Guider, guide scope or to guide a separate piggyback camera from
your main scope.  It is for advanced users with appropriate equatorial tracking mounting
systems.

Filter Menu

The commands in the Filter menu are used for controlling the Color Filter Wheel accessory and
are discussed in the separate CCDOPS Software Manual and in the manual that comes with the
Color Filter Wheel.

AO Menu

The commands in the AO menu are for use with SBIG’s other cameras, the ST-7 and ST-8, to
acquire images in conjunction with the AO-7 Adaptive Optics Unit.  They don’t pertain to the
ST-5C and can be easily ignored.

This basic preview should make you comfortable with the ease of moving around in CCDOPS
and what it entails.  You can exit through the File menu now.  Notice how a warning box still
alerts you that you are leaving an unsaved image that will be lost when you exit.  Specify
"Quit:Yes" and hit Enter to leave CCDOPS.  If you want more information about CCDOPS
please refer to the separate CCDOPS Software Manual.

2.1.3. Connecting the Camera to the Computer

Place the camera's CPU midway between the computer and the telescope or some other
convenient place.  With the power to the CPU disconnected, plug the Optical Head into the
CPU at the marked location and plug the beige parallel cable provided with the system into the
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CPU.  Connect the other end of the parallel cable into your computer's Parallel port (printer
port).  Finally plug the power supply into the CPU.  At this point the camera should activate the
small motor in the optical head to find the home position on the internal shutter wheel and the
camera should be ready to use.

Important Note:  Never connect or disconnect the CCD head from the CPU box unless the power
cord is unplugged from the CPU. Damage to the CCD head, or the CPU could
occur.

2.1.4. Establishing a Communications Link with the Camera

Run the CCDOPS software and when it starts up, it will automatically attempt to establish a
link to the camera.  If the camera installation is successful, the "Link" field in the Status Window
is updated to show the Link status.  If the camera is not connected or the LPT port setting has
not yet been properly set, a message will be displayed indicating that the software failed to
establish a link.  If this happens, use the Communications Setup command in the Misc menu to
configure the CCDOPS software for the parallel port you are using.  Then use the Establish
COM Link command in the Camera menu to re-link.

Note: Under Windows 95 it’s hard for CCDOPS to tell exactly which port is
LPT1, which is LPT2, etc.  If you can’t establish a link to the camera on
the port you think it’s on try the other port settings.  Once you find
which port CCDOPS thinks the camera is on you can use the
Advanced settings in the Graphics/Comm Setup command to copy
the address of the port you found the camera on to the port it should
be on.

2.1.5. Operating your  Camera with CCDOPS - a Daytime Orientation

With the Camera menu highlighted, select the Setup command.  Notice the choices for
temperature regulation, etc.  Ignore these for the time being and hit the Cancel button or the Esc
key to get rid of the dialog.  Again select the Camera menu and then execute the Grab
command.  Note the exposure time, etc.  Verify that the exposure time is set to 1.00  second and
other settings are Dark frame:Only, Auto display:Analysis (DOS Only), Exposure delay:0 and
Special processing:None.  With the CCD camera nosepiece uncovered, hit Enter.  A sequence of
events occurs and you will notice a spotted image.  This represents a 1 second exposure dark
frame at your room temperature with the CCD chip still covered by the internal mechanical
shutter wheel to keep out light.

At this point let’s examine the image on a pixel-by-pixel basis using the Crosshairs.  For
Windows 95 and Macintosh users select the Show Crosshairs command in the Display Menu.
For DOS users the Display Menu shows up to the upper-left of the image.  Click on it with the
mouse (or just hit Enter), select the Xhairs item and hit Enter.

You are presented with a lot of data pertaining to the small crosshair cursor (+) now
located in your dark frame image.  The cross placement is now in your control and is used to
obtain pixel information.  Move it around with the arrow cursors (DOS) or rapidly by mouse
point and click.  Notice 9 lines of data in the X-Hair box that are updated with each pixel
position movement.  A convenient zoomed box located below and left of the entire main image
magnifies the immediate area surrounding the crosshair cursor.  The very center of this zoomed
box represents the cursor position.  Move the crosshair toward the top of the frame. Now slowly
move it, an arrow stroke at a time, to find a dark pixel (low value). A reading of 400 to 1400 is
typical.  Now move it to the bottom of the image and note the brightest pixel value.  It might  be
in the range 1200-1300. A single very hot pixel could give a value of 3000.  Hitting Enter again
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brings up more advanced crosshair commands.  Hit Esc twice to view just the image.  This is
what you will typically view after you capture an image.

Next, Esc back to the main menu and hit the Grab command again.  Select Dark
frame:None.  With the camera nosepiece uncovered, hit Enter to begin another exposure.  This
time you are taking a light frame.  Notice how smooth the image looks. Repeat  the above steps
used in evaluating pixels in the dark frame.  Notice that they all saturated with 32,767 counts.
This is the maximum amount of light entering as photons and converted to electrons that the
CCD can read.

Next, cover the nosepiece of the camera and use the Grab command again, only this time
select Dark frame:Also and hit Enter.  This image has a much lower background and range, and
represents a dark subtracted image.  Still, pixel intensity variations fall between 50  and 250.
Some individual hot and cold pixels may show at 30 to 900 counts, but their Average Value is
100 or so.  This "Avg" value (displayed in the crosshairs data) represents the low end intensity
of your pixel image data, while 32,767 represents the maximum intensity value.  All your CCD
image data is represented as shades of grey between 100 and 32,767 counts.  This is a very large
range, far beyond the photographic process capability.

Let's Esc to the main menu and use the Setup command in the Camera menu.  We will
cool the camera to 0 degrees C. with a new Setpoint setting of 0.  Also, set Temperature
regulation to Active.  Nothing happens yet until you hit Enter.  Notice the lower corner of the
Camera Status that shows Temperature and that it is rapidly dropping.   When it stabilizes at
around 0, you can see the percentage cooler capacity you are using shown in parentheses.  Grab
another dark subtracted image(Dark frame:Also) and study the display.  First notice the much
more uniform look the pixels show.  The benefits of CCD cooling are very evident.  Notice that
the average count remains consistently around 100  but that the pixels are much more closely
clustered around 100 counts.3

If your room temperature is about 70 degrees F., try further cooling to -8 degrees C.
Nearly 100% cooler capacity may be indicated.  For good astroimages, don't run above 90%.
Grab an image once the temperature stabilizes in the -8 degree range.  Notice that the image is
even more uniform appearing now.  The average pixel count is still around 100, but "hot" pixels
have greatly diminished except for an errant few that may always read high.  No amount of
cooling can help these.  They are inherent in the manufacture of most CCDs.

Summary

Even at a 1 second exposure, the value of cooling is demonstrated to be important as well as the
dark taking and subtraction procedure.  These steps are absolutely necessary to get the most
from your CCD camera.  If you were at the telescope, all that would be left to do is to save this
image.  Let's do that now but first we will need to create a directory for some images.  Under
Windows 95 or the Mac OS you can do this from the File Save dialog when you got to save the
image.  Under DOS you use the Create Directory command in the File menu to make a new
directory for our images.  Execute the command and when it asks you for a directory name type
CCD.4 Hit Enter to create the directory.

Finally, get back to the main menu and use the Save command in the File menu.  Type a
name for the image (that follows your OS naming convention).  Then use the Open command in
the File menu and look for your name there. Highlight it and hit Enter to open it.  Notice the
displayed header data has the file name you gave it, the date and time setting of your computer
as well as exposure time and temperature, etc.  Some other parameters were not yet set by you
                                                                        
3 You might think the pixel values would be clustered around 0 counts but instead they are clustered

around 100.  That's because the CCDOPS software adds 100 counts to the dark subtracted image to
stop pixels from going below zero when the two images are subtracted.  Just remember that 100
counts represents zero signal.

4 As a convenience the software makes up directory names for you by adding the current month and
day to DATA.  You can use this name or type in your own name.
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and may be incorrect. Refer to the CCDOPS manual and the Telescope Setup and Edit
Parameters commands for more on this.  This data will always be connected with the saved
image as long as it is viewed by any CCDOPS software such as a friend's or a magazine's.5

Repeat the above procedures to capture, display and save images until you are confident
enough to take the next step of coupling your CCD camera to a telescope at night.  This time,
before you exit the software, use the Shutdown command in the camera menu.  You want to do
this before you pull the power to the CPU so that it has a chance to let the cooler warm up a bit
before the power is turned off.  After using the Shutdown command give the CPU 30 seconds or
so before pulling the power.  If you try to exit the software with the cooling on, the software
will prompt you to shut it down first.

2.2. The First Night with the Camera

Focusing a CCD camera can be a tedious operation, so a few hints should be followed.  Before
using the software to focus the camera the first time, you should place a diffuser (such as scotch
tape, wax paper or ground glass) at the approximate location of the CCD's sensitive surface
behind the eyepiece tube and focus the telescope on the moon, a bright planet , star, or a distant
street lamp.  This preliminary step will save you much time in initially finding focus.  The
approximate distance behind the eyepiece tube for your CCD camera is 0.660 inches as shown
in the figure below.

Telescope

Back Focus ≈ 0.660

Diffuser

0.660

CCD
Camera

Figure 2.2 - Camera Back Focus

Your CCD camera has a T-Thread on the front and is supplied with a screw-in 1.25 inch
nosepiece.  Most users will find simply inserting the nosepiece into the telescope focuser in
place of the eyepiece the most convenient.  Using the camera with other T-Thread accessories
like eyepiece projection adapters is also possible.  At first, just use the nosepiece.

Orient the camera as shown in the figure below and drape the optical head's cable over
the telescope fork so that it is not hanging free and being dragged by the telescope which could
cause the telescope to have erratic RA (Right Ascension) motion.  The orientation shown below
has the CCD's wide axis (X) aligned with RA and the narrow axis (Y) aligned with Declination.
Re-balance the telescope as required.

                                                                        
5 Note that it's always a good idea to display the image and adjust the background and range

parameters to your liking before you save the image.  That way the CCDOPS software will remember
the settings and use them the next time you load and display the image.
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Figure  2.3 - Camera Orientation

If you haven't done so already, power up the CCD camera and computer.  Under the Misc
menu use the Telescope Setup command to enter your telescope information.  For the Aperture
item enter the clear aperture in square inches (for example an 8" SCT is 43 square inches).  The
focal length will be close to the product of the telescope diameter and the f-ratio (for example an
8" f/10 has an 80" focal length).  Finally enter your name in the User item.  These parameters are
saved with each image in the image header.6

2.2.1. Focusing the Camera

The telescope should be polar aligned and tracking.  Since at this point you can be fairly far out
of focus, we recommend you start with a relatively bright star (2nd Magnitude or brighter).
Visually center the telescope on the star using your finder/guide scope or by sliding an
eyepiece in and out of the telescope without readjusting the telescope focus knob.

Use the Focus command in the Camera menu and set up for a 1 second exposure, Full
frame, Automatic update, Zero delay and Auto grab disabled.  When you hit the Enter button,
the software will start taking images, displaying them on the screen one after another.

What you will typically see is a huge, out of focus star image.  On an SCT if the focus is
off enough, you'll see an image of a donut with the telescope's central obstruction showing in
the middle of the star.  On refractors there won't be any central obstruction.  At this point you
adjust the telescope's focus, causing the star's image to shrink until it is a fairly small, bright
spot.  When you get close to focus, you will see the star starts to bloom, with streaks protruding
above and below the core of the star.  In fact, the signs of a really good focus is when the
blooming tails are their longest.  For now don't worry about getting a perfect focus, just get
close.  When you think you are focused hit the ESC key to exit from focus mode.

Now, reposition the telescope on a dimmer star, 5th or 6th Magnitude should work well.
We want to do the critical focus on a star that won't saturate the camera.  Reenter the Focus
command using a 3 second exposure and the Planet frame mode.  The 3 second exposure allows
the camera to average out some of the atmospheric effects.  The Planet frame mode takes a full
frame image and then allows you to position a box around the star using the mouse or
keyboard in order to reduce download time.  You can also resize the default box as desired.

                                                                        
6 Refer to Section 5, the Software Reference section for a more detailed description of the Telescope

Setup command.
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To position the planet frame with the mouse, click and drag the upper-left and lower-
right corners of the box or click and drag the center.  To position it with the keyboard (DOS
only), you use the arrow keys in combination with the T key.  The T key toggles whether you
are moving the Center, the Upper-Left or the Lower-Right corner of the box.  You can see which
is currently selected in the upper-left corner of the display adjacent to the Hot label.  Once you
have placed or redrawn the box, proceed with the Focus command by hitting the L key (for
located).7

You achieve critical focus by watching the Peak value displayed in the upper-left corner
of the display (DOS) or in the Focus Window (Win 95 & Mac) and adjusting the telescope focus
until the highest peak value reading is achieved.  We recommend you start on one side of focus
and adjust the telescope a little at a time.  On the first pass just get a feel for what sort of peak
reading you'll be able to achieve and don't worry if you go past the peak.  In fact, make sure you
have gone through the peak and the peak values are dropping off or the star image is
deteriorating.  Then back up the focus and go through it again, this time stopping when you get
close to the peak readings from the first pass.  For SCT's always approach exact focus with a
counter-clockwise focus knob movement.

2.2.2. Finding and Centering the Object

Once best focus is achieved, we suggest changing the Focus command  to the "Dim" mode to
help center objects.  This mode gives a full field of view, increased sensitivity,  but reduces
resolution in order to increase the digitization and download time.  If you have difficulty
finding an object after obtaining good focus, you can remove the head and insert a medium or
low power eyepiece.  Being careful not to adjust the focus knob on the telescope, slide the
eyepiece in until the image appears in good focus. Then visually find and center the object, if it
is visible to the eye.  If not, use your setting circles carefully.  Then, re-insert the CCD head and
set an exposure time of about ten seconds.  Center the object using the telescope hand controls.
Remember, your CCD chip is only 2.4 x 3.2 mm or the size of a match head.  This field of view is
like using a 4-6 mm focal length ocular!

Note: With a 10 second exposure, objects like M51 or the ring nebula are easily detected with
modest amateur telescopes.

2.2.3. Taking an Image

Take a CCD image of the object by selecting the Grab command and setting the exposure time
to 60 seconds.  Set the Dark Frame option to Also so the software does an Auto-Dark
subtraction, set with Image size to full and enable Auto Display. The camera will expose the
CCD for the correct time, download and then display the image.  You can then save it or keep
trying your acquisition and focusing technique

When you are through for the night don't forget to use the Shutdown command in the
Camera Menu before you pull the power on the CPU.

2.3. Further Foray’s into CCDOPS

The CCDOPS software that comes with the ST-5C has many capabilities and will serve you well
in your imaging pursuits.  At this time we refer you to the separate CCDOPS Software manual
for guidance and detailed technical information on that software’s capabilities.  Section 3

                                                                        
7 You don't have to remember all the key names.  The CCDOPS software has a pull down menu in the

upper-left corner of the display (named Focus in this case) that you an click on with the mouse or pull
down with the Enter key.  You can then make choices from that pull-down menu.
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below, “Advanced Imaging Techniques” will also give you some good insight into how to
effectively use your camera.
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3. Advanced Imaging Techniques
The following sections describe some of the advanced uses of CCD cameras.  While you may
not use these features the first night, they are available and a brief description of them is in
order for your future reference.

3.1. Taking a Good Flat Field

If you find that flat field corrections are desired due to vignetting effects or for more accurate
measurements of star magnitudes, try either taking an image of the sky devoid of stars or take
an image of a blank wall or neutral grey card that is evenly illuminated.

Finding areas of the sky devoid of stars is very difficult after twilight.  Therefore, you
should take flat field images of the night sky after sunset, but long before you can see any stars.
If this is not possible, take an image of a featureless wall or card held in front of the telescope.
However, if using this second method, be sure that the wall or card is evenly illuminated.  Do
not use a flashlight to directly illuminate a card, but rather allow the light to bounce off of
another card or the wall of your observatory opposite the one you are imaging.  Use a diffuse
light source.

If you plan on flat fielding Track and Accumulate images, you should also refer to
section 3.6.  Since the same flat field is added to itself a number of times, be sure that you do not
saturate the flat field image by starting with pixel values too high.  Typically try to keep the
pixel values between 10% to 20% of saturation for this purpose.  For single flat field images, try
to keep the values to approximately 50% of saturation.  That is a value of roughly 8,000 counts
for the TC-255 in Hi-Res and 32,000 counts binned.

3.2. Track and Accumulate

An automatic Track and Accumulate mode is available in CCDOPS which simplifies image
acquisition for the typical amateur with a good telescope drive.  Drives employing PEC or PPEC
technology and accurate gears, only need adjustment every 30 to 120 seconds.  With Track and
Accumulate the software takes multiple exposures and automatically co-registers and co-adds
them.  The individual exposures are short enough such that drive errors don't show up and the
accumulated image has enough integrated exposure to yield a good signal to noise ratio.

Procedurally, the camera will take an exposure, determine the position of  a preselected
star, co-register and co-add the image to the previous image in the CPU, and then start the cycle
over again.  Up to 64 images can be co-added.  The resulting exposure is almost as good as a
single long exposure, depending on the exposure used and sky conditions.  The great sensitivity
of the CCD virtually guarantees that there will be a usable reference star within the field of
view.  This new patented feature provides dramatic performance for the amateur, enabling
unattended hour long exposures!

3.3. Color Imaging

The field of CCD color imaging is relatively new but expanding rapidly.  Since your CCD
camera is equipped with a monochromatic CCD, discriminating only light intensity, not color,
some provision must be made in order to acquire color images.  Your camera has been designed
with color imaging in mind, with the ability to easily upgrade the camera with an internal color
filter wheel in place of the standard shutter wheel.

The color filter wheel allows conveniently placing colored interference filters in front of
the CCD in order to take multiple images in different color bands.  These narrow band images
are then combined by software to form a color image.  The Red, Green and Blue pass filters are
used to acquire three separate color images of the object.  The resulting images are combined to
form a tri-color image using the CCDCOLOR software.
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Color imaging places some interesting requirements on the user that bear mentioning.
First, many color filters have strong light transmission in the infrared (IR) region of the
spectrum, a region where CCDs have very good response.  If the IR light is not filtered out, then
combining the three images into a color image can give erroneous results.  If your Blue filter has
a strong IR leak (quite common), then your color images will look Blue.  For this reason, you
place an IR blocking filter in front of the three color filters.

Second, since you have narrowed the CCD's wavelength response with the interference
filters, longer exposures are required to achieve a similar signal to noise compared to what one
would get in a monochrome image with wide spectral response.  This is added to the fact that
tri-color images require a higher signal to noise overall to produce pleasing images.  In black
and white images your eye is capable of pulling large area detail out of random noise quite
well, whereas with color images your eye seems to get distracted by the color variations in the
noisy areas of the image.  The moral of the story is that while you can achieve stunning results
with CCD color images, it is quite a bit more work.  Fast optical systems, f/2 through f/6.3,
work best.  Focal reducers also help.

3.4. Autoguiding

The CCDOPS software allows the CCD camera to be used as an autoguider through the
commands in the Track menu.

When used as an autoguider, the CCD camera repeatedly takes images of a guide star,
measures the star's position to a fraction of a pixel accuracy, and corrects the telescope's position
through the hand controller input.  While autoguiding alleviates the user of the tedious task of
staring through an eyepiece for hours at a time, it is by no means an end-all cure to telescope
drive corrector performance.  All the things that were important for good manually guided
exposures still exist, including a good polar alignment.  Use of an auto guider is to correct for
the small drive errors and long term drift, not to slew the telescope or compensate for a poor
drive.

One of the reasons that autoguiders are often better than human guiding is that rather
than just stabbing the hand controller to bump the guide star back to the reticule, it gives a
correction that is the precise duration necessary to move the guide star back to its intended
position.  It knows how much correction is necessary for a given guiding error from the
Calibrate Track command.  The Calibrate command, which is used prior to autoguiding,
exercises the telescope's drive corrections in each of the four directions, measuring the
displacement of a calibration star after each move.  Knowing the displacement and the duration
of each move calibrates the drive's correction speed.

To autoguide you need to connect the camera's Telescope port to your telescope's CCD
input.  On Celestron Ultima, Losmandy and LX-200 mounts this is accomplished with the small
6 conductor "telephone" cable provided with the camera.  Simply plug one end into the
Telescope port on the camera's CPU and the other end into the telescope.  On Ultima and
Losmandy mounts you will need to unplug the hand controller and plug the auto guiding cable
in its place.  On the LX-200 you plug the cable into the CCD jack.  Finally if you have an older
telescope that does not support the 6 pin CCD port contact SBIG Technical Support and inquire
about custom hand controller modifications and whether you need an external Relay Adapter
box.

3.5. Field Operation

The ST-5C Advanced CCD Camera is supplied with a wall transformer for operation off
110 VAC that provides 12 VDC output to the camera.  You can run the camera off of a car
battery when operated in the field.  If you are interested in this please contact SBIG or refer to
Appendix A for the power jack pinouts.
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4. Glossary

Antiblooming Gate - When a CCD pixel has reached its full well capacity, electrons can
effectively spill over into an adjoining pixel. This is referred to as blooming. The
Antiblooming gate can be used to help stop or at least reduce blooming when the
brighter parts of the image saturate.

Astrometry - Astrometry is the study of stellar positions with respect to a given coordinate
system.

Autoguider - All SBIG CCD cameras have auto guiding or "Star Tracker" functions. This is
accomplished by using the telescope drive motors to force a guide star to stay precisely
centered on a single pixel of the CCD array. The camera has four relays to control the
drive corrector system of the telescope. The CCD camera head is installed at the guide
scope or off axis guider in place of a guiding eyepiece.

CCD - The CCD (Charged Coupled Device) is a flat, two dimensional array of very small light
detectors referred to as pixels. Each pixel acts like a bucket for electrons. The electrons
are created by photons (light) absorbed in the pixel. During an exposure, each pixel fills
up with electrons in proportion to the amount of light entering the pixel. After the
exposure is complete, the electron charge buildup in each pixel is measured. When a
pixel is displayed at the computer screen, its displayed brightness is proportional to the
number of electrons that had accumulated in the pixel during the exposure.

Dark Frame - The user will need to routinely create image files called Dark Frames. A Dark
Frame is an image taken completely in the dark. Dark Frames are subtracted from
normal exposures (light frames) to eliminate fixed pattern and dark current noise from
the image. Dark Frames must be of the same integration time and temperature as the
light frame being processed or numerous hot and cold pixels occur.

Dark Noise - Dark Noise or Dark Current is the result of thermally generated electrons building
up in the CCD pixels during an exposure. The number of electrons due to Dark Noise is
related to just two parameters; integration time and temperature of the CCD. The longer
the integration time, the greater the dark current buildup. Conversely, the lower the
operating temperature, the lower the dark current. This is why the CCD is cooled for
long integration times. Dark noise is a mostly repeatable noise source, therefore it can be
subtracted from the image by taking a "Dark Frame" exposure and subtracting it from
the light image. This can usually be done with very little loss of dynamic range.

Double Correlated Sampling - Double Correlated Sampling (DCS) is employed to lower the
digitization errors due to residual charge in the readout capacitors. This feature results
in lower readout noise.

FITS Image File Format - The FITS image file format (which stands for Flexible Image
Transport System) is a common format supported by professional astronomical image
processing programs such as IRAF and PC Vista. CCDOPS can save image files in this
format but can not read them.

Flat Field - A Flat Field is a image with a uniform distribution of light entering the telescope.
An image taken this way is called a flat field image and is used with CCDOPS to correct
images for vignetting.

Focal Reducer - A Focal Reducer reduces the effective focal length of an optical system. It
consists of a lens mounted in a cell and is usually placed in front of an eyepiece or
camera.  With the relatively small size of CCDs compared to film, focal reducers are
often used in CCD imaging.
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Frame Transfer CCDs - Frame Transfer CCDs are CCDs that have a metal mask over some
portion (usually half) of the pixel array. The unmasked portion is used to collect the
image. After the exposure is complete, the CCD can very quickly shift the image from
the unmasked portion of the CCD to the masked portion, thus  protecting the image
from light which may still be impinging on the CCD. This acts as an electronic shutter.

Full Well Capacity - Full Well Capacity refers to the maximum number of electrons a CCD
pixel can hold. This number is usually directly proportional to the area of the pixel.

Histogram - The Histogram is a table of the number of pixels having a given intensity for each
of the possible pixel intensities. Remember that, in the end, the image file is nothing
more than a list of pixel values, one for each CCD pixel.

Light Frame - The Light Frame is the image of an object before a Dark Frame has been
subtracted.

Path/Filter - The Path setting tells CCDOPS which directory and disk drive to find and store the
image files. In essence, it defines the current directory.  The filter controls which image
files are shown in the Open directory.  Only files that match the filter are shown.  For
example, a filter setting of "*.255" will only show files that have a "255" extension.

Photometry - Photometry is the study of stellar magnitudes at a given wavelength or bandpass.

Photons/ADU - This is an indication of the camera's gain in converting incoming light into
image counts.  This value is used with programs such as Hidden Image.  For any image
you take the Photons/ADU is shown in the Parameters command from the Image menu.

Pixel Size - The smallest resolution element of a CCD camera is the CCD pixel. The pixel size
for your camera is 10 microns square (10 by 10 microns)

Planet Mode - Planet Mode is the most useful way to achieve focus. When you select Planet
mode, a full frame is exposed, downloaded, and displayed on the computer monitor. A
small window can be placed anywhere in the image area and the size of the window can
be changed. Subsequent downloads will be of the area inside the box resulting in a much
faster update rate.

Quantum Efficiency - Quantum Efficiency refers to the fractional number of electrons formed
in the CCD pixel for a given number of photons. Quantum Efficiency is usually plotted
as a function of wavelength.

Readout Noise - Readout noise is associated with errors generated by the actual interrogation
and readout of each of the CCD pixels at the end of an exposure. This is the result of
fixed pattern noise in the CCD, residual charge in the readout capacitors and to a small
extent, the noise from the A/D converter and preamplifier.

Readout Streaking - When a bright object is imaged using a short exposure time, readout
streaking can occur. Readout streaking can look similar to blooming except it extends
across the entire image passing through the bright object. This is a result of image shift
at the beginning and again at the end of an exposure due to frame transfer. The readout
streaking is usually very faint with respect to the overall image and can sometimes be
eliminated from the display image by slightly raising the background level.

Resolution Mode - The resolution of a CCD camera is determined by pixel size. Pixel size can
be increased by combining or binning more than one pixel and displaying it as one pixel.
Doing so decreases the effective resolution but speeds up the download time of the
image. Maximum resolution is determined by the smallest size of the individual CCD
pixel.

Response Factor - Response Factor is a multiplier used by CCDOPS  to calibrate a telescope for
photometric calculations.  The Response Factor multiplied by 1000 is the number of
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photoelectrons generated in the CCD for a 0th magnitude star per second per square
inch of aperture.

Saturation - Saturation refers to the full well capacity of a CCD pixel as well as the maximum
counts available in the A/D converter. The pixel is saturated when the number of
electrons accumulated in the pixel reaches its full well capacity. The A/D is saturated
when the input voltage exceeds the maximum.

Sky Background - The sky background illumination or brightness is the number of counts in
the image in areas free of stars or nebulosity and is due to city lights and sky glow.  High
levels of sky background can increase the noise in images just like dark current.  For
some deep sky objects, filters can be used to reduce the sky background level.

Seeing - Seeing refers to the steadiness and the transparency of the atmosphere during an
observing session.

TE Cooler - The TE Cooler is a Thermo-electric cooling device used to cool the CCD down to
operating temperature. The CCD is mounted to the TE  Cooler which is mounted to a
heat sink, usually the camera head housing.

TIFF Image File Format - The TIFF image file format (which stands for Tagged Interchange File
Format) was developed jointly by Microsoft and Aldus Corporations to allow easy
interchange of graphics images between programs in areas such as presentation and
desktop publishing. CCDOPS can save image files in this format but it can not read
them.

Track and Accumulate - The Track and Accumulate function is an patented feature of CCDOPS
that allows the user to automatically co-register and co-add (including dark frame
subtraction) a series of images of an object. These exposures can be taken unguided as
long as the "Snapshot time" does not exceed the length of time before tracking errors of
your clock drive become apparent. This allows you to image and track without guiding
or the need to connect the CCD Relay port to your drive motors.

Track List - The Track List is a file generated by CCDOPS during a Track and Accumulate
session. The Track List logs all the corrections made by CCDOPS for each of the images.
Track lists are required when flat fielding Track and Accumulate images.

Tri-Color - Tri-Color refers to color images created using three different colors mixed into a
balanced color image using red, green and blue filters. An object is imaged three times,
once with each color filter. The three images are then co-added and color balanced with
the appropriate software.

Vignetting - Vignetting is obstruction of the light paths by parts of the instrument.  It results in
an uneven illumination of the image plane.  The effects of vignetting can be corrected
using flat field images.
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5. Hints and Tips

This section contains hints and tips to get the most use out of your camera and software.  There
is a section of Question and Answers to the most common questions followed by several
sections of tips.

5.1 Question and Answer

This section contains answers to some of the more common questions we hear in the Technical
Support department.

Q. Is there a short cut to focusing the camera?  A. We find the best method to be using the peak
brightness as described in the manual but there are almost as many opinions here as there are
people.

Q. How often do I need to refocus?  A. When there has been a big temperature change (3 °F) or
when you have moved to a different region of the sky with an SCT, you should consider
refocusing.

Q. What is the back focus of the camera?  A. Please refer to Figure 2.2.

Q. What is the  extra rectangular bar that came with the camera ?  A. It is a tripod mount that you
screw into the side of the camera that allows you to mount the camera on a tripod if you plan to
fit it with camera lenses.

Q. Can I use a camera lens with the camera?  A. Yes, SBIG sells an adapter for the camera that
allows you to use C-mount or other lenses with the camera.

Q. Can I operate the camera off of a car battery?  A. Yes you can.  You'll probably want to use a deep
cycle marine battery and you'll have to purchase a cable.

Q. How cold should the CCD get?  A. You should be able to work around 30 degrees Celsius
below ambient.

Q. Who should I contact when I have questions or problems with the camera?  Contact SBIG  and ask
for Technical Support. If your questions are general in nature you might try subscribing to the
SBIG User List on the Internet.  Technical support information and instructions on how to
subscribe to the SBIG User List can be found on our home page at <www.sbig.com>.

Q. How long of a cable can I use between the PC and the CPU?  A. You should be able to use cables
up to 100 feet in length but it will vary from PC to PC.

Q. Where can I get a longer cable?  A. Go to your nearest computer store and ask for a 25 pin male
to female extension cable.

Q. Where can I get a shorter cable?  A. Go to your nearest computer store and ask them to make
you a short 25 pin male to female crimp type cable.

Q. Why does the software say there isn't enough memory?  A. You need to make sure you have at
least 1 Megabyte Extended memory and that the HIMEM.SYS driver is loaded into your
CONFIG.SYS file.  Also check that other entries in the CONFIG.SYS or AUTOEXEC.BAT files
are not consuming too much memory.

Q. I see dark  spots in my images, what causes them?  A. If the dark spots are a single pixel they are
typically caused by hot pixels in the CCD saturating and can be removed with the Remove Cool
Pixels command.  If they're several pixels wide you should suspect dust on the window and
that effect can be removed with flat fielding your images or clean the window with an "air
duster".

Q. My images have dark tendrils in the corners.  What can I do?  A. These are caused by the CCD
frosting and you need to replace the desiccant as described in Appendix C.4.
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Q. Can I write my own software for the camera?  A. Appendix B describes the file format used to
save images.  You can also request an Application Note from the manufacturer telling how to
interface and program to the camera.

Q. Is there other software available for the camera?  A. You can upgrade your camera with the Color
Filter Wheel and CCDCOLOR software.  Also there are several third party software packages
for image processing, camera control and various printer output.

Q. Can I run the software under Windows,?  A. While we don't recommend running the CCDOPS
software under Windows you should be able to do it.  Also Software Bisque's SkyPro software
supports the camera under Windows and is fully integrated with their excellent The Sky
software.  Contact Software Bisque at (303) 278-4478.

Q. What do I do if my images have elongated stars?  A. If using Track and Accumulate you are
probably using a snapshot time that is too long. If the snapshot time is longer than the amount
of time your drive can track unguided with acceptable guiding errors, you will see elongated
stars in your final images.  If your snapshot times are getting down to 30 seconds or less you
should improve your drive.

If you are using your camera as an autoguider for film photography and are noticing
unacceptable guiding errors, please check the following:

1. Can you move the telescope using the Move command? This is an indicator
as to whether or not you are properly connected to your drive system via the
relay cable from the CPU.

2. Be sure that your calibration time gives at least 10 to 50 pixels of movement
for each step of the Calibrate command.

3. Check for flexure between the CCD camera head and your system. Check for
flexure between the guide scope or off-axis guider and your telescope system.
This is a very common source of guiding errors. A very small movement of
the CCD head with respect to the guide scope during an exposure can cause
unacceptable streaking.

4. If your mount is stable, try longer exposure times while tracking to average
out the atmospheric effects.

Q. What do I do if my CCD frosts?  A. If your camera starts to frost after a year of use it's time to
replace the desiccant as described in Appendix C.

Q. The moon is too bright, what do I do?  A. Try a full aperture solar filter.  Try a variable rotating
neutral density filter.  Don't use off-axis apertures smaller than 4" or you give up resolution.

Q. What exposure is best for planets?  A. Use the crosshairs mode to measure the disk's intensity.
Make sure that the pixels are about 75% saturated.  This should give a good range of brightness.
Sometimes moons can also be imaged at the long end of the exposure range.

Q. Which laptop is best for CCD use?  A. Nearly any laptop will work; however, you should take a
copy of CCDOPS with images and run it from any units you are considering.  Color LCD isn't
necessary unless it is your only computer.

Q. Why are my images grainy looking and not smooth?  A. The grainy look is from low signal to
noise.  A longer integration time will increase signal and reduce graininess.  Try doubling
exposure times.  This works up to a point where you begin picking up sky background (light
pollution) which limits maximum practical integration times.  Also make sure your cooler is
running at 75% capacity or more.

Q. What are the advantages of shorter focal lengths and faster F# telescopes?  A. Shorter focal lengths
increase the field of view, allowing you to image larger objects.  Faster F# telescopes increase
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the field of view and shorten the exposure times.  Do not underestimate the benefits of focal
reducing your f/10 SCT systems!

5.2. CCDOPS Use Tips

• If you display an image and nothing shows, check that the Auto Contrast was enabled.

• When selecting a Track and Accumulate guide star, it is not necessary to exactly set  the
cursor on the center of the selected star.  It automatically snaps to the brightest pixel, not
necessarily the geometric visual center.

• Co-adding images together, whether guided or accumulated, averages out noise and results
in a smoother image than one single long exposure.  Keep in mind, the longer the individual
exposure, the higher the signal to noise until you reach background sky limits.  You will
find that at f/10, a single 60 second exposure will be grainy for low contrast objects and 5
minutes may be the minimum tolerable, requiring off-axis guiding or a guide scope.  At
f/6.3, this snapshot time may be 1 minute and at f/2 it may be 10 seconds.  Don't be afraid
to experiment with poorly guided images of varying exposure times to learn what works
best.  Co-adding many underexposed images still results in inferior results.  This is
especially true for tricolor.

• If you are fortunate enough to have access to a full aperture solar filter, daytime use with the
CCD camera is possible at f/6.3 to f/10.  Distant power poles and power lines silhouetted
against the sky work well as a target.  Use binning since turbulence will limit resolution.
This will allow you to learn the software flow in daylight.

• Dark frames aren't necessary for short exposures of bright objects (Jupiter at f/20 with 2x
Barlow projection or the moon).

5.3. Hints and Tips for Laptop Users

• If you mainly use your laptop for field use with CCDOPS, it is possible to modify your
AUTOEXEC.BAT file to boot directly into CCDOPS, saving time.

• If your laptop is monochrome, obtain a small piece of red litho stripping film (rubylith) to
slip in front of the LCD display.  Most print shops have the red plastic.  Use it matte side
out.

• You can stack your laptop directly on top of the CPU for a compact package.  You could
make a custom 8" ribbon type cable to couple the CPU to the laptop.  The cable is wired pin
1 to pin 1, etc.  See Question #11 on page 73.

• Cursor movement through CCDOPS is much faster using the mouse, especially if your
laptop has one of the small keyboard based pen-point mice.

• Some LCD displays dim when it is very cold outside.  A small heat pad behind the display
can help.

• Don't be afraid to adjust display brightness on your computer in the course of viewing an
image.  Negative views require opposite settings.

• Try to use a laptop with 64 shade gray display capability.  Some laptops have a display
setup mode in their resident software to optimize.  VESA compliant is also useful for real
time cursor contrast changes.

• LAPLINK software and cables allow easy next day image file transfer to your main
computer.  This is very handy.
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• Images will always look better when displayed on a video monitor, however, an active
matrix LCD display is pretty close except in brightness.

• You may wish to change your display and hard drive sleep cycles (battery conservation) to
longer "keep awake" times so as not to interfere with image acquisition (long Track and
Accumulate).

• LED flashlights help to see the keyboard when the display is dimmed red.

5.4. Telescope Tips

• Always verify best collimation prior to installing the CCD camera.

• Always secure the camera head cable to the optical tube assembly.  Never let the cable
dangle free from the focuser/ocular holder.

• Off-axis guiding is worth it, even on a bunch of 3 minute co-adds of a deep sky object.

• Don't guess on focus.  If you're not sure, it is time to refocus.

• Take time to frame your object.  Rotate the camera 90 degrees to take advantage of the CCD
chip's 3:4 aspect ratio and don't forget to refocus again.

• Focal reduce as much as possible for deep sky objects.  Exposure times are then shorter and
signal to noise gets better.  2-3 arc-seconds per pixel (30" focal length) is plenty of resolution
for deep sky objects, especially nebulae.  Good tracking is still critical down to 12" focal
lengths in hi-res mode.  Always polar align to minimize Dec drift.

• Focusing micrometers really help, especially on SCTs where you want to always enter the
best focus position on a counterclockwise knob rotation.  This advances the primary mirror
forward against gravity and preloads bearings, screw threads and any mirror/baffle
rocking.  A light knuckle rap prior to exposure or guiding is advisable to settle moving
components.  It is always possible to ascertain exact focus only after you have passed a peak
intensity and then come back to the peak's setting.  You may not see the exact high value,
but will see the trend at best focus position. Again, don't guess at focus.

• Focusing on planets is difficult since seeing can uniquely blur each frame.  If a planet's moon
is present, use the slow motion hand control to move over to it.  Readjust exposure time
accordingly and refocus on it, then bring the planet back into view and capture it.

• If track problems exist, first check balance in declination and then RA since they interact.
Verify the 1 1/4" camera head coupler doesn't rock in the telescope bushing and that it is
flush at it's coupler flange with bushing.  Check drive clutches or clamps.  Check drive rate
setting.  With guiding ocular visually check PEC setting or reprogram.  Trails seen on only
the brightest stars along the short axis of the CCD is blooming, not tracking.

• Real dark skies are not necessary for beautiful CCD images of deep sky objects.  CCDs are
far superior to film with or without filters in this respect.  Tricolor CCD will benefit from
dark skies, but still works great compared to color film.

• Simple 2 element refractors can show bloated stars due to chromatic aberration since CCDs
have a wide spectral response and a very wide dynamic range of signal.  Filters can help or
quality multi-element color corrected refractors.

• Always keep an eye on ambient temperature changes.  A 3 degree Fahrenheit change can
affect SCT focus enough to merit refocusing.  Temperature drop = clockwise movement of
SCT focus knob (yes, the way you didn't want to move it).

• Closely re-align your finder as needed to the CCD image on the screen to speed up object
acquisition.  Don't use a 90 degree diagonal to visually acquire objects and expect them to be
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in the CCD camera view.  The chip is only .1 x .13 inch in size and 90 degree diagonals are
never rotationally collimated to optical axis close enough to use for CCD work.  Special laser
collimated diagonals are available for this purpose as well as CCD framing oculars with
exact reticle patterns to match the CCD chip.

• Digital setting circles with hi-res encoders (1/12 degree or better) can get you close to faint
objects if you are polar aligned and they are "dialed in" as well.

• Integrating Software Bisque's "The Sky" software into your imaging system is another help
in object acquisition, but adds new complexity to the operations until after you are
comfortable with CCDOPS and CCD imaging.  It is then a very interactive tool.

• Don't bother with deep sky imaging on an Alt/Az configured mount even if it tracks.
Image rotation results and precludes co-adding, etc. in most instances.  Use a wedge and
polar align such systems for best and simplest results.

• Wait for both telescope and CCD camera to thermally settle in before trying for optimal
results.  Typically wait 1/2 to 1 hour after setting up and running.  This is a good time to set
up software, balance scope, and polar align, etc.

• Use a dew shield on SCTs to prevent dewing and minimize stray light.  Re-balance as
necessary.  CCDs have a tremendous dynamic range.  Bright stars at the edge of the field
can spray light across nebula, especially Veil, Horsehead, California nebulae.  Anti-
blooming can't help scattered light.  Reposition field slightly and try again.

• Due to small 10 micron pixels (.0004") the TC-255 works best at shorter focal lengths of 12" -
80".  An 8" aperture is an ideal match for this imager.  A bigger scope and larger chip will
just scale results like a larger format 6x7 camera compared to a 35mm camera.  A TC-255
and 8" SCT can offer years of imaging capability before plunging into bigger/better with
more money.  Tricolor should be the next progression before scaling up.

• Fast telescopes with high resolution optics offer remarkable imaging characteristics with
CCD cameras, especially tricolor.  Exposure times are short, excellent tracking is easier,
signal is awesome, therefore contrast of colors in deep sky objects is spectacular enough to
warrant color dye sublimation prints that rival photographic color prints done with film
through much larger telescopes at a much higher difficulty level.  Takahashi Epsilon, Flat
Field cameras and specialized SCTs are hard to match in performance.

• Off-axis guiding is necessary to fully exploit the great imaging potential of your CCD
camera.  Even with an 8" SCT @ f/6.3, the 50" focal length offers 1.6 arc seconds/pixel
resolution, much finer than optimum photographic results.  Many of the software's sample
SCT images were off-axis guided to produce small round high resolution stars.  No matter
how good your mount is, count on guiding to get the most from your CCD camera.
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A. Appendix A - Specifications

This appendix lists the specifications for the SBIG ST-5C AdvancedCCD camera.

CCD Texas Instruments TC255
Active Area 3.2 x 2.4 mm (.126" x .094")

Field of View 5.4 x 4.1 arc minutes at 80 inch focal length (8" F/10)
1/2° x 1/3° at 16 inch focal length

Pixels/Pixel Size 320 x 240 @ 10 microns square
Read Noise 25e- RMS

Dark Current Typically 1e-/p/s at -5°C
Full Well Capacity CCD : 50,000 e-

A/D : 41,000 e- with Photons/ADU set at 1.25
Cooling Single Stage Thermoelectric, Selectable Setpoint

A/D Converter 16 Bit, 22 KHz Pixel Rate
Power Requirements 12 VDC at 1.2 Amps

Telescope Port 4 Open Drain Outputs
Communications Port Interfaces to PC Parallel Port

Electronic Shutter .01 to 3600 seconds
Mechanical Shutter Rotary Shutter Wheel
Color Filter Wheel Available as Option

Weight of Optical Head Under 1 pound
(less cable)

Size of Optical Head 3.25" diameter by 2.7" deep
F# throughput of Filter Wheel f/2 - f/30

A.1 DC Power Jack

Ground in Center

+12VDC on outside

Mating plug is 5.5mm
outside and 2.1mm inside

Figure A.2 - DC Power Jack

A.1 Communications Port

Pins 2 - 5 Data 0 through Data 3 to Camera
Pins 6,7 Address 0, 1 to Camera

Pin 9 Strobe to Camera
Pins 15,13,12,10,11 Data 0 through Data 4 from Camera

Pins 18 - 25 Data Ground
Shell Chassis Ground
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A.1 Telescope Port

1 2 3 4 5 6
1 = +RA (Right)
2 = +DEC (Up)
3 = -DEC (Down)
4 = -RA (Left)
5 = Ground
6 = No Connect

Figure A.3 - Telescope Port

Note that the four outputs are active-low, open-drain outputs without internal pull-ups and are
capable of sinking 250 mA DC to ground when activated.  They have a breakdown voltage of
45V, a typical on resistance of 1.3Ω and an avalanche energy of 75 mJ for driving inductive
loads.
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B. Appendix B - Maintenance
This appendix describes the maintenance items you should know about with your CCD camera
system.

B.1. Replacing the Fuse

The CPU is internally fused with a 2 amp fast blow fuse. The fuse is located inside the CPU box
on the printed circuit board. Remove the four screws on the bottom of the CPU box to access the
fuse holder.

B.2. Disassembling/Reassembling the Optical Head

In order to gain access to the CCD for cleaning or desiccant removal, please follow these
instructions or return to the manufacturer for service.

1. Remove the four screws holding the front cover onto the camera and set the
cover aside.

2. Remove the shutter/filter wheel from the camera by pulling it straight up out
of the camera, lifting it off the axle.

3. Remove the three hex-head screws that hold the inner housing into the
camera.  The inner housing covers the CCD, making a hermetic chamber for
the CCD and desiccant.  Lift the inner housing and set it and the O-Ring
aside.

At this point you have access to the CCD and all the windows in the system as well as the
desiccant pack.  To reassemble the camera please do the following:

1. Make sure the desiccant packet is in place below the CCD so that it may be
captured by the inner housing.  You may find it necessary to take the two
outer corners of the desiccant and turn them inwards, making the rectangular
packet somewhat conform to the round outline of the inner housing.

2. Seat the O-Ring in the groove in the bottom of the inner housing and gently
place the inner housing down into the camera.  Place careful attention to not
pinching the desiccant packet under the seat of the inner housing.  The
proper orientation of the inner housing is with the window over the CCD.

3. Tighten each of the three hex-head screws one-half turn at a time until the
inner housing is seated completely and flatly into the camera.

4. Place the shutter/filter wheel back into the camera with the side containing
the small reference marks and the larger brass bearing towards the CCD.
You will have to slightly deform the O-Ring that surrounds the wheel against
the shaft of the motor and be careful not to pinch or tear it.

5. Replace the front cover, noting that there is only one orientation that will fit
as the four mounting screws are at irregular angles.

B.3. Cleaning the Optical Windows

The design of the ST-5C allows for cleaning of the CCD.  The optical heads are not evacuated
and are quite easy to open and clean. Follow the instruction in the section above to gain access
to the CCD and clean it using one of the following 3 methods:

1. To remove dust from the windows, a can of dust remover can be used but be
careful to hold the can in the proper orientation.  If you tilt the cans too far
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from upright a stream of cold liquid (the propellant) will issue forth rather
than the burst of air.

2. In lieu of canned air, a small, soft, camel hair brush can be used to wipe dust
from the windows.

3. Finally, for hard to remove particles or water spots, use a Q-Tip lightly
dampened in Isopropyl Alcohol to clean the windows.

Note: The key to cleaning optical surfaces is successive cleanings with a fresh Q-tip
each time.

B.4. Replacing the Desiccant
This section describes the replacement procedure for the desiccant used in your camera.  The
desiccant absorbs moisture in the CCD chamber, lowering the dew point below the operating
temperature of the cooled CCD, thus preventing the formation of frost.  The desiccant is
contained in a small rectangular package inside the CCD chamber.  In normal operation the
useful life of the desiccant is over a year.  If the CCD chamber is opened often, the desiccant
should be replaced when frosting is noticed.

Follow the instructions in the section above to gain access to the CCD chamber and
desiccant packet.  Discard the old packet and replace it with a fresh one.  Note that the desiccant
material in the packet can be regenerated by baking it in an oven at 400 degrees Fahrenheit for
four hours but you'll have to remove the desiccant from the packet first .  Otherwise the packet will
melt.  In a pinch you could snip the end of the packet off, pour out the desiccant beads, bake
them out, pour them back into the packet and reseal the packet with scotch tape.
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